
   Unit 3  
Word Processing and presentations: Word Processing 
Basics: Using MS Word/Google Docs – formatting, styles, 
tables, mail merge.  
Presentation Tools: Using PowerPoint/Google Slides – slide 
design, animations, transitions. Applications: Creating 
resumes, reports, brochures, and presentations. Keyboard 
Shortcuts. 
 
Microsoft Office (MS Office) 
Microsoft Office (MS Office) is a collection of application 
software developed by Microsoft Corporation. 
It is mainly used for office work, documentation, presentations, 
data management, and communication. 
It helps students, teachers, businesses, and professionals to 
create, edit, and manage different types of documents easily 
and efficiently. 
History 

• MS Office was first introduced in 1989 for Apple 
Macintosh computers and in 1990 for Windows. 

• It was developed by Bill Gates’ company – Microsoft 
Corporation. 

• Over the years, several versions have been released such 
as: 
MS Office 95, 97, 2000, 2003, 2007, 2010, 2013, 2016, 
2019, and Office 365. 

• The latest versions include cloud-based features that allow 
users to work and save documents online using OneDrive. 

Main Components of MS Office :- 
1. MS Word 
Microsoft Word is a word processing application used to create 
and edit text documents. 
It helps in preparing letters, resumes, reports, books, and 
notices. 
You can change the font, size, colour, and style of text and 
insert tables, images, charts, and clip arts easily. 



It also provides spelling and grammar checking and allows 
printing and saving of documents. 
Example: Creating a school report or a business letter. 
2. MS Excel 
Microsoft Excel is a spreadsheet program used for storing and 
managing numerical and tabular data. 
It allows you to perform mathematical and logical calculations 
using formulas and functions. 
It also helps in creating charts and graphs to analyze data 
visually. 
Excel is widely used for accounting, budgeting, and data 
analysis. 
Example: Creating a student marks list or monthly expense 
sheet. 
3. MS PowerPoint 
Microsoft PowerPoint is a presentation software used to create 
slideshows that include text, images, charts, videos, and 
animations. 
It is useful for delivering lectures, business meetings, and 
seminars. 
You can apply designs, transitions, and animations to make 
slides more attractive. 
Example: Preparing a college project presentation. 
 
4. MS Access 
Microsoft Access is a database management system (DBMS) 
used to store and manage large amounts of data efficiently. 
It allows users to create tables, queries, forms, and reports for 
better data handling. 
Access is helpful for organizations that need to maintain 
records such as student details, employee data, or inventory. 
Example: Maintaining a student database in a college. 
5. MS Outlook 
Microsoft Outlook is an email and personal information 
management tool. 
It helps in sending and receiving emails, scheduling meetings, 
and storing contacts. 



It also includes a calendar, task manager, and reminder system 
to manage work efficiently. 
Example: Sending official emails or scheduling online meetings. 

Word Processing:- 
    A word processor is a general-purpose application software 
used to create, edit, and store different types of documents such 
as letters, articles, books, and reports. It allows users to work 
mainly with text, numbers, symbols, pictures, and clip arts. 
Word processors like MS Word and Google Docs, zoho writer  
provide many features such as changing font style, size, colour, 
and alignment, as well as creating tables and performing mail 
merge operations. These tools make document creation faster, 
easier, and more accurate. 
Additionally, they allow printing documents neatly and support 
colourful graphical presentations, making the final output 
attractive and professional. Some of the popular word 
processors are Microsoft Word, Google Docs, LibreOffice 
Writer, and WPS Office, Zoho writer. 
 
Main Features of Word Processing:- 
1. Creating Documents 
Word processors allow users to create different types of 
documents such as letters, reports, resumes, books, and 
notices. 
You can start with a blank document or use built-in templates 
to save time. 
2. Editing Tools 
You can easily add, delete, move, copy, or replace any part of 
the text. 
Editing in a word processor is very simple and can be done 
instantly without retyping the entire page. 
3. Formatting Text 
Formatting helps to make your document attractive and 
professional. 
You can change font type, size, colour, alignment, line spacing, 
and apply bold, italics, underline, and highlighting to important 
words. 



4. Spell and Grammar Check 
Word processors automatically check your spelling and 
grammar as you type. 
Errors are underlined, and the software provides suggestions to 
correct them, improving accuracy and quality 
5. Inserting Tables and Charts 
You can insert tables, charts, and graphs to display data clearly. 
This is useful for reports, marks lists, invoices, and research 
papers. 
6. Mail Merge 
Mail merge allows you to send the same letter to many people 
by automatically changing names and addresses. 
It saves time and effort when preparing invitations, result 
letters, or salary slips. 
7. Inserting Pictures and Clip Art 
Images, logos, and clip art can be added to make documents 
visually appealing. 
This feature is very helpful in designing brochures, newsletters, 
and posters. 
8. Page Setup and Layout 
You can adjust page margins, size, and orientation (portrait or 
landscape). 
You can also set columns, page borders, and background colors 
for better presentation. 
9. Header, Footer, and Page Numbering 
You can add a header (top section) or footer (bottom section) 
with information such as titles, author names, dates, or page 
numbers. 
This makes documents more organized and professional. 
10. Find and Replace 
This feature helps you quickly locate specific words or phrases 
in a document. 
You can also replace them automatically with new text, saving 
time in large documents. 
11. Saving and Printing Documents 
Documents can be saved in various formats like .docx, .pdf, or 
.txt. 



You can also print them easily with options for page range, 
colour, and layout settings. 

Advantages of Word Processing:- 
1). Easy Editing :- 
Word processors make it very simple to modify text at any time. 
You can add, delete, copy or move text without retyping the 
entire document. This flexibility helps in saving both time and 
effort during corrections. 
2). Formatting features :- 
You can make your document more attractive by changing the 
font style, size, colour, and alignment. Word processors also 
allow you to highlight important text, add bullet points, and 
adjust spacing to improve readability. 
3). Time- Saving :- 
Creating and editing documents on a computer is much faster 
compared to manual typing. Built-in tools like templates, copy-
paste, and auto-correct help complete tasks quickly and 
efficiently. 
4). Spell and Grammar Check: 
The software automatically checks spelling and grammar while 
typing. It underlines errors and suggests corrections, which 
helps improve the accuracy and professionalism of the 
document. 
5). Mail Merge Feature: 
Mail merge is used to create personalized letters or emails for 
multiple recipients. It automatically replaces names and 
addresses from a data list, saving a lot of manual work and 
ensuring consistency. 
6). Multimedia Insertion: 
You can insert pictures, clip art, charts, tables, and graphs to 
make the document more appealing. This is especially useful 
for reports, newsletters, and brochures where visuals help in 
better understanding. 
7). Printing and Sharing: 
Documents can be printed in various formats with different 
page layouts and colors. You can also share them easily through 



email or cloud platforms, making collaboration faster and more 
convenient. 
8).Security: 
Word processors offer password protection to keep confidential 
documents safe. This ensures that only authorized users can 
access, edit, or print the file, providing data privacy and 
security. 

Applications of Word Processing :- 
Word processing applications like MS Word and Google Docs 
are widely used in schools, colleges, offices and businesses for 
creating and managing documents. They help users to type, 
edit, format and print different types of documents quickly and 
neatly. 
1). Creating letters and official documents :- 
Word processors are used to prepare letters, circulars, and 
official notices neatly and professionally. You can easily edit 
names, addresses, and dates without rewriting the entire 
documents. This is especially useful for business letters and 
company communications. 
2). Preparing Reports and Projects :- 
Students, teachers, and employees use word processors to write 
project reports, assignments, and annual reports. 
They can include headings, bullet points, tables, and charts to 
make the reports well-organized and clear. 
3. Designing Resumes and Cover Letters 
Job seekers use word processors to design resumes and cover 
letters. 
Features like templates, borders, and alignment tools help in 
creating professional-looking documents that attract 
employers. 
4. Creating Brochures and Newsletters 
Organizations and educational institutions design brochures, 
pamphlets, and newsletters using MS Word. 
With tools for inserting images, clip art, and color themes, it’s 
easy to make creative designs. 
 
 



5. Writing Books, Articles, and Journals 
Authors and researchers use word processors to write books, 
articles, journals, and research papers. 
The spell-check, grammar-check, and page numbering features 
help them write efficiently and accurately. 
6. Mail Merge for Mass Communication 
Mail Merge is a special feature used to send the same letter to 
many people, with each copy having a different name or 
address. 
This is useful for sending invitations, salary slips, and result 
letters. 
7. Creating Question Papers and Certificates 
Teachers can use word processors to prepare exam question 
papers and certificates. 
It saves time and allows easy reuse of templates for future 
documents. 
8. Preparing Forms and Applications 
Word processing software helps design application forms, 
feedback forms, and registration forms using tables and shapes. 
These forms can be printed or shared online. 
9. Documentation and Record Keeping 
Offices use word processors to maintain meeting minutes, 
agreements, and legal documents. 
Files can be stored digitally for future reference, avoiding paper 
storage. 
10. Creating Invoices and Bills 
Small businesses use word processors to create invoices, 
quotations, and billing formats quickly using tables and 
automatic numbering. 

Common Uses of MS Word:  
• Writing letters, resumes, and reports.  
• Preparing presentations with text.  
• Designing brochures, flyers, and newsletters.  
• Creating academic and professional documents. 
 
 
 



Examples of word processing software :- 

Software name Developer  Platform  

Microsoft word  Microsoft  Windows, mac 

Google Docs  Google  Web-based 

WPS writer  Kingsoft  Windows, Android  

Apple pages Apple inc. macOS, ios 

 

Formatting in MS Word :- 
Formatting means changing the appearance, style, and layout 
of the text or document to make it look clear, attractive and 
professional. In word processing formatting helps organize 
information properly so that the document becomes easier to 
read and understand. 
Formatting can be divided into two main types :- 
1. character or text formatting. 
2. paragraph and page formatting. 
1). Character or Text formatting :- 
Character formatting refers to the changes you make to 
individual characters or words in a document. 
Common character formatting options:- 
1. font style and size :- 
    You can change the font type (e.g., Arial, times new roman 
etc..) and  font size to make the text look better. 
Shortcut : ctrl+D (to open font dialog box). 
2. Bold, Italic and underline:- 
These styles help to highlight important words or headings. 
 Bold (ctrl+B) → makes text darker 
Italic (ctrl+I)→ slants the text 
Underline (ctrl+U) → adds a line below the text. 
3. font color and highlighting:- 
You can change the text color and use a highlighter to 
emphasize important words. 
Shortcut for highlight : alt+H+I 
4. change case :- 
Converts text between uppercase, lowercase, title case etc.. 
Shortcut : shift+F3 

Formatting is the process of modifying text, paragraphs, and pages to make a document clear, readable, and attractive.



5. subscript and superscript:- 
Subscript :- text appear slightly below the line  
Superscript :- text appears slightly above the line. 
2). Paragraph Formatting :- 
Paragraph formatting  applies changes to entire paragraphs – 
not just individual words. 
Shortcut :- 
Left : ctrl +L 
Center : ctrl +E 
Right : ctrl+R 
Justify : ctrl+J 
line and paragraph spacing :- 
Adjusts the amount of space between lines or paragraphs (e.g., 
1.0, 1.5, 2.0). 

• Shortcut: Ctrl + 1 (single), Ctrl + 2 (double spacing) 
Indentation: 
Moves the text inward from the left or right margin to create 
clear structure. 
Useful for starting new paragraphs or quotations. 
  Bullets and Numbering: 
Used to list items clearly using symbols (•) or numbers (1, 2, 3). 
  Borders and Shading: 
Adds decorative lines or background colors to paragraphs to 
highlight important sections. 
3). Page Formatting 
Page formatting affects the overall appearance of the page 
layout. 
Common Page Formatting Options: 

1. Page Margins: 
Adjusts the white space around the edges of the page. 

o Found in Layout → Margins 
2. Page Orientation: 

Sets the page direction — Portrait (vertical) or Landscape 
(horizontal). 

3. Page Size: 
Selects paper size such as A4, Letter, or Legal. 



4. Headers and Footers: 
Allows adding text (like titles, page numbers, or dates) at 
the top (header) or bottom (footer) of each page. 

5. Page Borders and Colors:                                                                                                                                                                                          
Adds borders or background colors to improve the 
document’s visual appearance. 

Styles in MS Word:- 
In MS Word, a Style is a set of predefined formatting options 
that can be applied to text to change its appearance quickly and 
consistently. 
Styles help make documents look professional, neat, and 
uniform without manually changing each formatting option like 
font, color, or size again and again. 
A Style is a collection of formatting features, such as: 

• Font type, size, and color 
• Bold, Italic, and Underline effects 
• Line spacing and paragraph alignment 
• Borders and shading 

Types of Styles in MS Word 
1. Paragraph Style 

o Used to format entire paragraphs. 
o Controls alignment, spacing, indentation, and line 

spacing. 
o Example: Normal, Heading 1, Heading 2. 

2. Character Style 
o Used to format selected text or characters. 
o Controls font, size, color, and bold/italic effects. 
o Example: Emphasis, Strong. 

3. Linked Style (Paragraph + Character) 
o Can be applied to both paragraphs and selected text. 
o It combines the properties of both paragraph and 

character styles. 
4. Table Style 

o Used to format tables in a consistent way. 
o Defines borders, shading, and text alignment for 

table cells. 



5. List Style 
o Used to format lists (bulleted or numbered). 
o Controls bullet style, number type, and indentation. 

How to Apply a Style in MS Word 
1. Select the text or paragraph you want to format. 
2. Go to the Home tab on the Ribbon. 
3. In the Styles group, click on a style (e.g., Heading 1, Title, 

Subtitle). 
4. The selected text will automatically take that style’s 

format. 
How to Create a New Style 
Method 1: From the Styles Group 

1. Click the Home tab → In the Styles group, click the small 
arrow (▼) at the bottom-right corner. 

2. Click on Create a Style → then click Modify. 
3. In the Modify Style box: 

o Type a name for your style. 
o Choose font, size, color, spacing, alignment, etc. 

4. Click OK → your new style will appear in the style list. 
Method 2: From Formatted Text 

1. Format a piece of text manually (e.g., font size, color). 
2. Select that text. 

3. In the Styles group, click the arrow ▼ → choose Save 
Selection as a New Quick Style. 

4. Give it a name and click OK. 
 
Shortcut Keys Related to Styles :- 
Ctrl+Shift+N   → apply normal style 
Ctrl+Alt+1      → apply heading 1 style 
Ctrl+Alt+2    → apply heading 2 style 
Ctrl+Alt+3    → apply Heading 3 style 
Alt+Ctrl+Shift+S → open styles pane 
 
 
 
 



Tables in MS Word :- 
A table in MS Word is a grid made up of rows and columns that 
helps to organize information neatly. 
Each box in the grid is called a cell, and it can contain text, 
numbers, or images. 
Ex:- 

Name Group Marks 

Sri Rama Msc Computer 98 

Gnanambica BSC 99 

Venkateswara BCA 97 

 
This is a table with 3 columns and 3 rows. 
How to create Table :- 
Method 1: Using the Insert Tab 

1. Go to the Insert tab on the Ribbon. 
2. Click on Table. 
3. Drag your mouse over the grid to select the number of 

rows and columns you want. 
4. Click — the table will appear in your document. 

 Method 2: Using “Insert Table” Option 

1. Go to Insert → Table → Insert Table. 
2. Enter the number of rows and columns. 
3. Click OK. 

 Method 3: Draw Table 

1. Go to Insert → Table → Draw Table. 
2. The cursor changes to a pencil icon — now you can draw 

custom-sized rows and columns manually. 
Editing and Formatting Tables 
After creating a table, you can modify it easily. 
 Add or Remove Rows/Columns: 

• Right-click inside the table → choose Insert → Insert 
Rows/Columns. 

• Or press Tab key at the end of the last cell to automatically 
add a new row. 

 
 



 Merge and Split Cells: 

• Merge Cells: Select cells → Right-click → Merge Cells. 

• Split Cells: Select cell → Right-click → Split Cells → 
choose number of rows/columns. 

 Adjust Row Height and Column Width: 

• Place cursor on a line between two cells → drag it to adjust 
the size. 

Apply Borders and Shading: 

• Go to Table Design tab → Borders or Shading. 
• You can change border color, thickness, and background 

color. 
 Align Text Inside Cells: 

• Select the cell(s) → Right-click → Table Properties → Cell 
→ Vertical Alignment (Top, Center, Bottom). 

Uses of Tables 
-To prepare marks lists, attendance sheets, and reports. 
-To organize data and calculations. 
-To create invoices, resumes, schedules, etc. 
-To make the document more professional and readable. 
 
Shortcut Keys:- 

Action Shortcut Key 

Move to next cell Tab 

Move to previous 
cell 

Shift + Tab 

Add a new row at 
the end 

Tab (from last cell) 

Select a column Alt + Click 

Select a row Shift + Spacebar 

Merge cells Alt + A + M 

Split cells Alt + A + P 

 
 
 
 
 



Mail Merge :- 
Mail merge is a feature in MS Word that helps you create 
multiple personalized documents such as letters, certificates, 
emails, labels and envelopes by combining. 
1. a main document (letter or template) 
2. a data source (excel file, address list, outlook contacts, etc..) 
     Instead of typing each letters separately, mail merge 
automatically inserts details like name, address, roll numbers, 
marks, etc. into the document. 

Uses of Mail Merge ? 
- to save time when preparing many similar documents 
- to avoid typing mistakes. 
- to produce consistent and professional documents. 
- to personalize each document automatically 
Ex :- creating certificates for 200 students with different 
names. 

Main components of mail merge :- 
1. Main Document :- 
The common content that is the same for all recipients. 
Ex:- a letter format, certificate template, invitation, etc. 
2. Data Source :- 
The list of individual information stored in : Excel sheet, CSV, 
Access database, outlook contacts, new address list. 
Ex:- name, address, phone, email, marks, roll number etc. 
3. Merge Fields :- 
Placeholders used in the document. 
Example: «Name», «Address», «RollNo» 
These fields get replaced with actual data during merging. 
Steps to Perform Mail Merge 
Step 1: Start Mail Merge 

• Open Word → Mailings tab 
• Click Start Mail Merge 
• Select document type (Letters, Email, Labels, etc.) 

Step 2: Select Main Document 
Choose Use Current Document 
(Your existing document becomes the template) 



Step 3: Select Recipients 
You can choose: 

• Type a New List 
• Use an Existing List (Excel file) 
• Select from Outlook Contacts 

Most commonly: 
Click Type a New List → Create 
 
Step 4: Enter Data 

• Add fields (Name, Address, etc.) 
• Customize fields (Add/Delete fields) 
• Enter all records 
• Save the list 

Step 5: Write Your Document 
Type your letter normally. 
Insert merge fields: 

• Click Insert Merge Field 
• Select fields like «Name», «Address», etc. 

These placeholders will be replaced with actual data. 
 
Step 6: Preview 

• Click Preview Results 
• Check if the data appears correctly 
• View each recipient’s letter 

Step 7: Complete the Merge 
Click Finish & Merge 

• Print documents 
or 

• Edit individual documents 
or 

• Send email (requires MS Outlook) 
 
 
 
 
 



Header and Footer in  MS Word :- 
Header and Footer are important tools in MS Word that help 
create a clean, professional, and well-organized document. 
They allow us to repeat information automatically on all pages, 
saving time and improving readability. 
Header :- 
    A header is the section at the top of every page in a word 
document. Anything written in the header will automatically 
appear on all pages (unless we change the settings). 
Examples:- Document title, chapter name, institution name, 
logo, author name etc. 
Why header is useful ? 
- it makes the document professional. 
- it helps identify the document when printed. 
- it saves time because we do not need to type the same text on 
every page. 
Footer :- 
A footer is the section at the bottom of every page in a word 
document. Anything written in the footer will appear on all 
pages. 
Examples :- page numbers, date, fill name, websites or email ID 
etc. 
Why footer is useful ? 
- it helps readers easily navigate long documents using page 
numbers. 
- important details like date or reference appear consistently on 
all pages. 
- it maintains a clean and organized look. 
How to insert Header and Footer in MS Word :- 
To insert a Header : 
1. open MS word. 
2. go to the insert tab 
3. click Header 
4. choose a style (blank, title, line etc..) 
5. type the text you want. 
6. click close header and footer or press Esc. 
 



To insert a Footer :- 
1. go to the insert tab. 
2. click footer. 
3. select a footer style. 
4. type the text. 
5. close the footer. 
Adding page numbers :- 
To insert page numbers:- 
1. go to insert → page number 
2. choose top of page (header) or bottom of page (footer). 
3. select the style. 
The page numbers will automatically appear on all pages. 
 
Difference between Header and Footer :- 

Header  Footer 

Appears at the top of the 
page. 

Appears at the bottom of the 
page 

Mostly contains title, chapter 
name, logo. 

Mostly contains page 
numbers, date, notes. 

Helps identify document or 
chapter. 

Helps with navigation and 
additional information. 

Readers looks at it first. Readers look at it fast. 

 
Important Shortcut Keys in MS Word :- 

Shortcut Key Action 

Ctrl+N Create a new document. 

Ctrl+O Open an existing document 

Ctrl+S Save the current document 

F12 Save as (save with a new 
name) 

Ctrl+P Print the document 

Ctrl+C Copy selected text 

Ctrl+X Cut selected text 

Ctrl+V Paste copied text  

Ctrl+Z Undo the last action 

Ctrl+Y Redo the last and one action 



Ctrl+A Select all text in the document 

Ctrl+ B Make selected text bold 

Ctrl+I Make selectd text italic 

Ctrl+U Underline selected text 

Ctrl+E Align text to the center 

Ctrl+L Align text to the left 

Ctrl+R Align text to the right 

Ctrl+J Justify text  

Ctrl+F Open the find dialog box 

Ctrl+H Open find and replace dialog 
box 

Ctrl+K Insert a hyperlink 

Ctrl+Shift+> Increase font size 

Ctrl+Shift+< Decrease font size 

Ctrl+Home Move to the beginning of the 
document. 

Ctrl+End Move to the end of the 
document 

Ctrl+1 Set single line spacing 

Ctrl+2 Set double line spacing 

Ctrl+shift+L Apply bullet points 

Ctrl+= Apply subscript 

Ctrl+Shift+ + Apply superscript 

Alt+F4 Close ms word 

Ctrl+W Close the current document. 

 
 
 
 
 
 
 
 
 
 



Presentation Tools in MS Office :- (MS 
PowerPoint) 
    In MS office, the primary presentation tool is Microsoft 
PowerPoint. It is widely used in education, business, seminars, 
training programs, and personal presentations. PowerPoint 
helps us create, design, organize, and present information in a 
visual and professional manner. 
        A presentation is made up of multiple slides, and each slide 
contains different types of content like text, images, charts, 
videos, audio, tables, and SmartArt.  
→ MS PowerPoint is an application software used to prepare 
slideshows or presentations. It includes tools for creating, and 
displaying information in a structured and attractive format. 

Features of Presentation Tools (MS PowerPoint) 
Slides 

• Slides are like pages of your presentation. 
• Each slide contains key points, headings, images, or 

diagrams. 
• You can add, delete, duplicate, or rearrange slides easily. 
• Slide Layouts help decide how your content appears. 

Example: 
Title Slide, Title and Content, Two-Content Layout, Picture 
Layout, Blank Layout 
Themes and Slide Design 
A theme is a ready-made design with matching colours, fonts, 
and backgrounds. 

• Themes provide consistency to the entire presentation. 
• Students can select professional themes like Office Theme, 

Ion, Wisp, Slice, etc. 
• “Variants” allow small changes in color or style. 

This saves time and makes your presentation look neat and 
attractive. 
Insert Menu 
The Insert tab lets you add different types of objects: 

✔ Text Box – For writing text anywhere on the slide 

✔ Pictures – Insert images from your computer 



✔ Online Pictures – Insert images from the internet 

✔ Shapes – For diagrams and flowcharts 

✔ SmartArt – Create organizational charts, process charts, 
cycles 

✔ Charts – Show data as bar, line, pie charts 

✔ Tables – Display data in rows and columns 

✔ Audio & Video – Add sound or videos to slides 

✔ WordArt – Decorative text 

These elements make a presentation more meaningful and 
visually engaging. 
Animations 
Animations give movement effects to text or objects. 
Types: 

1. Entrance (how the object enters) 
– Fade, Fly In, Zoom 

2. Emphasis (highlight the object) 
– Spin, Grow/Shrink 

3. Exit (how the object leaves) 
– Fade Out, Fly Out 

4. Motion Paths 
– Move the object in any path 

Animations help draw the audience's attention to key points. 
Transitions 
Transitions are effects that appear between slides. 
Examples: 

• Wipe 
• Push 
• Split 
• Fade 
• Morph 

Transitions make moving from one slide to another smooth and 
attractive. 
 
 
 



Slide Show 
The Slide Show feature displays the entire presentation in full 
screen. 
Shortcuts: 

• F5 – Start slideshow from the beginning 
• Shift + F5 – Start slideshow from current slide 

Useful for: 
• classroom teaching 
• business meetings 
• project seminars 

Notes and Handouts 
Notes 

• Each slide has a “Notes” section where the presenter can 
type reminders. 

• These notes are visible only to the presenter (using 
Presenter View). 

Handouts 
• PowerPoint can print multiple slides on one page as a 

handout. 
• Useful for distributing notes to students or meeting 

participants. 
Templates 
Templates are pre-designed presentations with ready 
slides, themes, and layouts. 
Examples: 

• Business Presentation 
• Marketing Plan 
• Lesson Plan 
• Portfolio 
• Event Invitation 

Templates save time and help beginners create professional 
slides. 
Export and Save Options 
PowerPoint allows exporting the presentation as: 

• PDF Document 
• Video File (MP4) 



• Image Files (JPG/PNG) 
• PPT/PPTX 
• Handouts 

This makes sharing and submitting presentations much easier. 

Applications of Presentation Tools :- 

Presentation tools such as MS PowerPoint and Google 
Slides are widely used in education, business, training, 
research, and personal activities. They help present information 
in a visual, structured, and engaging manner using slides 
that include text, images, charts, audio, and videos. 
Below are the major applications explained clearly: 
1. Education and Teaching 
Presentation tools are extremely useful for teachers and 
students. 
Uses in Education: 

• Teachers prepare lessons using slides with diagrams, 
pictures, and examples. 

• Students use PowerPoint for seminars, project 
presentations, and assignments. 

• Complex topics become easier to understand when 
explained with visuals, animations, and charts. 

Example: Explaining "Computer Architecture" or 
"Photosynthesis" using slides. 
2. Business and Corporate Meetings 
In companies, presentations help in decision-making and 
communication. 
Uses in Business: 

• Presenting sales reports, growth analysis, and 
performance reviews. 

• Explaining business strategies, new product launches, 
marketing plans, and project status. 

• Training employees using step-by-step slides. 
Example: A company showing quarterly profits using charts 
and graphs. 
3. Seminars, Conferences, and Workshops 
Every seminar or conference uses PowerPoint slides to explain 
content clearly. 



Uses: 
• Presenting research papers 
• Explaining case studies 
• Displaying main points, statistics, and conclusions 
• Keeping the audience engaged with visuals 

Example: A college lecturer presenting a research topic in a 
national conference. 
4. Training and Skill Development 
Presentation tools are widely used in training sessions. 
Uses: 

• Technical training 
• Soft skills training (communication, teamwork) 
• Safety training in companies 
• E-learning and online courses 

Example: A trainer teaching “Digital Marketing Basics” using 
slides with screenshots and examples. 
5. Marketing and Product Promotion 
Companies use presentations to promote their products and 
services. 
Uses: 

• Showing product features and benefits 
• Explaining pricing models 
• Presenting promotional offers 
• Highlighting customer testimonials 

Example: A mobile company presenting the features of a new 
smartphone. 
6. Government and Administrative Use 
Government officers use presentations for planning and 
reporting. 
Uses: 

• Displaying development plans 
• Project budgets 
• Progress reports 
• Public awareness programs 

Example: A district officer presenting disaster management 
plans. 



7. Personal and Creative Use 
Presentation tools are also used for personal tasks. 
Uses: 

• Creating photo slideshows for birthdays, weddings, or 
events 

• Designing invitations and greetings 
• Making a resume presentation 
• Creating simple brochures or posters 

Example: A student creating a photo album slideshow for a 
college farewell. 
8. Online Teaching and Virtual Presentations 
With the rise of online platforms like Zoom, Google Meet, 
and Microsoft Teams, presentations have become more 
important. 
Uses: 

• Online lectures 
• Webinars 
• Remote training 
• Virtual meetings 

Example: A lecturer using slides to teach “AI Basics” in an 
online class. 
Advantages of Presentation Tools  
Presentation tools such as MS PowerPoint and Google 
Slides offer several advantages that make communication 
effective, attractive, and easy to understand. These tools help 
present information using text, images, charts, animations, and 
multimedia, which improves the quality of presentations. 
Below are the major advantages explained clearly: 
1. Easy to Understand Information 
Presentation tools convert information into visual formats 
such as images, diagrams, charts, and videos. 
This helps the audience understand the topic more easily. 
Example: Explaining a company’s profit using a chart is easier 
than reading numbers. 
 
 
 



2. Attractive and Professional Look 
PowerPoint offers themes, templates, colours, 
backgrounds, and layouts that make presentations look 
clean, modern, and professional. 
This improves audience attention and makes the presenter’s 
work look well-organized. 
3. Supports Multimedia (Images, Audio, Video) 
Presentation tools support: 

• Pictures 
• Audio clips 
• Video files 
• Animations 
• GIFs 

This makes the presentation more interactive and engaging. 
4. Easy to Edit and Update 
Slides can be edited, rearranged, or updated quickly at any time 
without rewriting the entire content. 
Example: If a date or percentage changes, you only have to 
update the corresponding slide. 
5. Helps the Presenter Stay Organized 
Presentation tools allow the presenter to structure content 
clearly using: 

• Bullet points 
• Headings 
• Sub-headings 
• Flowcharts 
• Tables 

This helps the presenter stay on track and deliver information 
step-by-step. 
6. Time-Saving and Efficient 
Using templates, themes, and ready-made slide layouts helps in 
preparing presentations quickly. 
This saves time, especially for students and professionals. 
 
 
 



7. Enhances Audience Engagement 
Animations, transitions, and visual elements make the 
presentation more interesting. 
The audience stays focused and remembers key points better. 
 
8. Can Be Used for Online and Offline Presentation 
PowerPoint presentations can be: 

• Displayed on projectors 
• Shared on Zoom/Google Meet 
• Sent via email 
• Uploaded to the internet 

This flexibility makes presentations suitable for both classroom 
and online teaching. 
9. Easy to Share and Print 
Presentation tools allow saving in many formats like: 

• PDF 
• PPT/PPTX 
• Video 
• Images 

You can also print handouts for students or participants. 
10. Useful for All Fields 
Presentation tools are helpful for: 

• Education 
• Business 
• Research 
• Marketing 
• Training 
• Government planning 
• Personal projects 

This makes them essential in today’s digital world. 
Slide Design in Powerpoint :- 
Slide Design is the process of arranging text, images, colours, 
layouts, and visual elements in a presentation to make the 
content clear, attractive, and easy to understand. Presentation 
tools like MS PowerPoint and Google Slides provide different 
features to create well- designed slides. 



Components of slide design :- 
1). Themes : 
Themes are pre-designed styles in PowerPoint/Google Slides. A 
theme includes : colours, fonts, background designs, layouts. 
     When you select a theme, all slides automatically look 
uniform and professional. The main purpose of theme is it 
keeps your presentation consistent and saves time because you 
don’t have to design each slide separately. 
2). Layouts :- 
Layouts decide where text, titles and images will appear on the 
slide. 
Common layouts :- 

• Title Slide – for the first slide 

• Title and Content – for normal slides 

• Two-Column Layout – for comparing information 

• Picture with Caption – when including images 
3). Fonts and text formatting :- 
Fonts refer to the style of tex. Text formatting includes bold, 
italics, underline, size, and colour. 
4). Colours :- 
Colours affect the readability and attractiveness of the slide. 
5). Images & Icons :- 
Images and icons make the presentation visually attractive and 
easy to understand. 
6). Charts and Graphs :- 
Charts help to present numerical or statistical data in visual 
form. 
Types :- 
- Bar charts – compare values 
- Pie charts – show percentages 
- Line graphs – show changes over time. 
Charts make the audience understand complex information in a 
simple way. 
 
 
 



7). SmartArt Graphics :- 
SmartArt is used for showing structured information like: 
Processes, cycles, hierarchies(organization chart), 
relationships. Smartart makes ideas look professional and 
visually appealing instead of typing long text. 
8). Transitions :- 
Transitions are special effects applied between slides when 
moving from one slide to another. 
Examples : fade, wipe, push. 
    Use transitions lightly. Too many fancy transitions look 
unprofessional. 
9). Animations :- 
Animations are effects applied to text or objects inside a slide. 
Uses : 
- show bullet points one by one 
- make images appear smoothly 
- highlight a chart or diagram. 
 

Transitions in PowerPoint:- 
Transitions in PowerPoint are visual effects that occur 
when one slide moves (changes) to the next slide. They 
help make presentations look smooth, professional, and more 
interesting. 
Meaning of Slide Transitions:- 
A transition is an effect that controls: 

• How the current slide ends 
• How the next slide enters 
• The speed of the movement 
• Whether sound is included or not 

Transitions are applied between two slides. 
Important of Transitions :- 
1. Makes the presentation smooth 
Transitions help slides change naturally without sudden shifts, 
which makes the flow pleasant for viewers. 
 
 



2. Helps the audience follow the presentation 
When you begin a new point, chapter, or topic, a transition 
helps the audience understand that a new idea is starting. 
3. Keeps attention 
Simple transitions keep the audience focused and prevent the 
presentation from becoming boring. 
4. Makes presentation professional 
Using the right transitions gives your slides a clean and 
professional look, especially in business or academic 
presentations. 
5. Controls pacing 
With transitions, you can control how fast or slow slides appear. 
This helps in: 

• teaching step-by-step 
• seminar presentations 
• explaining topics one-by-one 

 
Types of Transitions :- 
1. Subtle Transitions (Simple Transitions) 
These are soft, simple, and professional-looking transitions. 
They do not distract the audience and are used in most 
academic and business presentations. 
Examples: 

• Fade – The slide slowly appears or disappears. 
• Push – The next slide pushes the current slide off the 

screen. 
• Wipe – The slide appears from one side like wiping a 

screen. 
• Cut – Instantly changes to the next slide with no effect. 
• Split – The slide splits into two parts to show the next 

slide. 
Best used for: 

• College presentations 
• Business/official slides 
• Seminar presentations 
• Simple and clean slides 



2. Exciting Transitions (Attractive Transitions) 
These transitions are more colorful, dramatic, and eye-catching. 
They add fun and movement to your presentation. 
Examples: 

• Bounce – The slide bounces while appearing. 
• Swivel – The slide rotates like a wheel. 
• Zoom – The slide zooms in/out quickly. 
• Flip – The slide flips like a card. 
• Rotate – The slide rotates before changing. 

Best used for: 
• Student presentations 
• Creative projects 
• Events or cultural program presentations 
• Presentations for children 

3. Dynamic Content Transitions 
These transitions affect only the content, not the whole slide. 
They help when slides have a lot of text or images. 
Examples: 

• Pan – The content smoothly moves across the slide. 
• Fade through black – The content fades into black and 

comes back. 
• Window – Content appears through a moving window-like 

frame. 
Best used for: 

• Slides with charts, graphs, images 
• Professional and educational presentations 
• Long explanation slides 

How to Apply Transitions in PowerPoint:- 
1. Open PowerPoint and go to the slide you want. 
2. Click on the Transitions tab on the Ribbon. 
3. Choose a transition effect from the group (Fade, Wipe, 

Push, etc.). 
4. Adjust settings: 

o Duration (speed of transition) 
o Sound (optional) 
o Apply to All (same transition for all slides) 



5. Preview the transition using the Preview button. 
 

Animations in PowerPoint :- 
Animations in PowerPoint are special effects that allow 
text, images, shapes, charts, and other objects to move or 
appear in different ways on a slide. Animations make a 
presentation more attractive, interactive, and easy to 
understand. They help the presenter display content step-by-
step and keep the audience focused. 
Types of Animations in PowerPoint :- 
1. Entrance Animations 
Entrance animations are used to make an object appear on the 
slide. They help in presenting information step-by-step instead 
of showing everything at once. This keeps the audience focused 
because only the current point is visible. Examples include 
Appear, Fade In, Fly In, Zoom, etc. 
2. Emphasis Animations 
Emphasis animations are applied to objects that are already 
visible on the slide. They are used to highlight or draw attention 
to important text, images, or shapes. These animations help the 
audience understand what point the presenter is explaining at 
that moment. Examples are Pulse, Spin, Grow/Shrink, 
Font Color Change, etc. 
3. Exit Animations 
Exit animations make an object disappear from the slide. They 
are useful when you want to remove old information and bring 
attention to the next point. This avoids unnecessary clutter and 
keeps the slide clean while presenting. Examples include Fade 
Out, Fly Out, Wipe Out, Disappear, etc. 
4. Motion Path Animations 
Motion path animations move an object from one position to 
another in a slide. They are useful for showing movement, 
processes, directions, or flow of information. PowerPoint 
provides ready-made paths like Line, Circle, Arc, and also 
allows drawing your own custom path. These animations make 
the presentation look dynamic and interactive. 
 



Importance of Animations 
Animations are useful because they: 

1. Present information step-by-step 
→ Bullet points appear one after another. 

2. Grab audience attention 
→ Important points can be highlighted. 

3. Avoid information overload 
→ Only necessary content appears at the right time. 

4. Explain concepts visually 
→ Arrows, charts, and images can move to show 
processes. 

5. Improve presentation quality 
→ Makes the slide look professional and engaging. 

 
 
 
 

Practical Questions :- 
Q1).  Create a Microsoft Word document on the topic 
“My College” and perform the following tasks: 

1. Type a paragraph of 8–10 lines about My College. 
2. Apply different font styles (Calibri, Times New Roman, 

Arial) to different lines. 
3. Change the font size of the heading to 20 and make it 

Bold. 
4. Apply Italic style to any two important sentences. 
5. Underline the important words like students, library, 

teachers, campus. 
6. Change the font color of at least 5 important words (e.g., 

red, blue, green). 
7. Highlight one full sentence using Text Highlight Color. 
8. Apply Line Spacing 1.5 to the whole paragraph. 
9. Save the file with the name My_College_Practical.docx. 

 
 
 



 
 
Q2:- Create a Basic Student Details Table 
Create a table with the following columns: 
Roll No, Student Name, Course, Year, Mobile Number, Address 

• Enter details of 10 students 
• Make the header row bold 
• Apply all borders 
• Center-align Roll No and Year columns 

Q3:- Create a professional Resume in MS Word 
without using templates. 
Your resume must include the following items and 
formatting: 
Required Sections 

1. Heading (at the top of the page): 
o Name 
o Address 
o Phone Number 
o Email ID 
o Insert your photo on the right side of the 

heading 
2. Objective: 

o Write 2–3 lines about your career objective. 
3. Educational Details: 

o Create a table with columns: 
Course / Institution / Year / Percentage 

o Fill at least 3 rows. 
4. Technical Skills: 

o Add bullet points listing your computer/technical 
skills. 

5. Declaration: 
o Write a short declaration and add your signature 

(type your name). 
 
 
 



 
 
Q4:-Internal Marks Announcement using Mail merge  
Create a Mail Merge Letter informing students about their 
internal marks. 
Include merge fields: 

• Student Name 
• Register Number 
• Subject Name 
• Marks Scored 
• Grade 

Use Type a New List option 
 
Q5:-  Create a PowerPoint presentation with 5 slides 
on any topic of your choice. 
Apply a Theme, use different Slide Layouts, and insert at least 
one Image 
Q6:-Prepare a presentation using Animations and 
Transitions. 
Use at least 2 animations (Entrance & Emphasis) and 2 
transitions (Fade & Wipe) 
Q7:-Insert a Table and Chart in a slide showing 
“Student Marks” for 5 students. 
Format the table with borders and colors 
 
 
 
 
 
 
 
 
 


